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I n t h i s c h a p t e r y o u w i l l l e a r n :
• How to Use a query to create a report

• How to Use grouping and summarizing in a report

• How to Modify an existing report design

• How to Export a report to MS Word and/or Excel

Case: What SUP, Inc.

You, Nathan, and Meagan are feeling rather confident in using Access. So far
you’ve created and modified tables, queries, and forms in your database, but you
are anxious to see some results of your work in a more formal presentation.

‘‘How are reports different from queries and forms?’’ Meagan asks.
‘‘Remember that forms are used to view and update information in the data-

base,’’ Kyle answers. ‘‘Queries are your means of asking questions about the data,
and reports are your means of expressing that information in a usable fashion.’’

He reminds you that, when exploring queries, you were able to use select,
update, and delete queries to locate certain information and were also able to
compute totals and statistics. However, those queries when printed were not for-
matted very well. Although they could be sorted, they didn’t have the header,
footer, grouping, or summarizing features of reports.

Kyle suggests that you start with using a query as your basis for a report and
as a means to learn more about the available reporting features of Access.

Use a Query to Create a Report

To demonstrate the use of queries in a report, Kyle created a simple select query
that lists the category id, product name, quantity, unit cost, and total cost of all
products in inventory. We can now create a report using this query. The first ques-
tion he asks is what information from this query needs to be displayed in a report.

‘‘Well, if you ask me,’’ says Nathan, ‘‘I’d like to see a report of our products
sorted alphabetically by product name. And I’d like to see each product’s quan-
tity, unit cost, and total cost.’’

‘‘Could we also add information to the report like the category name for each
item?’’ Meagan asks.

‘‘Sure,’’ Kyle responds.
He then explains the process for creating such a report and offers to demon-

strate it to you now.
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To create a report using a query:

1 Start Access.

2 Click the File tab and then click Open.

3 Navigate the Open window to the location of this text’s student files.
(The location would be the CD provided with the text or from your
computer lab’s server.)

4 Double-click ch13-01, which should be located in a Ch 13 folder.
(This is a modified version of the completed What SUP Inventory
file from previous chapters.)

5 Click the File tab and then click Save Database As.

6 Navigate the Save As window to the location where you wish to save
this file and type Ch13-01_student_name in the File Name: text box
(replacing student_name with your name).

7 Click Save.

8 Click Report Wizard in the Reports group of the Create tab on the
Ribbon. Click Open to bypass the security warning if need be.

9 Select Query: Product Query from the Tables/Queries drop-down list.

10 Click >> to select all fields for inclusion into this report, as shown in
Figure 13.1.

11 Click Next.

12 Click by Product Table to remove the automatic grouping (more on
this later), as shown in Figure 13.2.

13 Click Next two times, then select Product Name from the drop-down list 1
when asked about sorting; this will sort your report by product name.

Click here to move
all available fields
across

Figure 13.1
Creating a Report Using

the Report Wizard
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14 Click Next; then check the Adjust the field width check box so that
all fields fit on a page.

15 Click Tabular under the Layout section and Portrait under the Orien-
tation section; then click Next.

16 Type Report 1 as the title of your report, click the Modify the
report’s design option button, and then click Finish. Your window
should look like Figure 13.3.

17 Resize the Product Name, Category ID, Quantity, Unit Cost, and Total
Cost fields and titles as shown in Figure 13.4.

Click on the far right of this text box and you should see a two arrow size cursor.
Click and drag to the right to increase the width of the text box. Click on the top of the
text box to see a four arrow move cursor. Click and hold here to relocate a text box.

Figure 13.3
Design View of Report 1

Figure 13.2
Using the Report Wizard
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18 Click View and then click Report View. The top of your finished
report, created from a query, should look like Figure 13.5.

Resized Product Name title and field

Resized Total Value title and field

Resized Unit Price title and field

Figure 13.4
Modified Design View of Report 1

Figure 13.5
Top Portion of Report 1
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Kyle further explains that it is best to create a report from a query that has
all the information you need. Kyle suggests that you learn more about reports
by working on grouping and summarizing information.

Use Grouping and Summarizing in a Report

Kyle explains that grouping arranges the records in your report. When you group
records, each group that shares a common characteristic is displayed together.
You can group based on one or several characteristics. Furthermore, Kyle
explains that—once a report has groups assigned—those groups can be summar-
ized in many ways, including subtotals, grand totals, average, and so on.

‘‘Can I get a report that lists my inventory by category and also subtotals
each group?’’ Nathan asks.

‘‘Sure,’’ says Kyle. ‘‘But I suggest we learn how to group first and then
worry about summarizing later.’’

Grouping
‘‘Let’s create a report similar to the one we just created but grouped by category
name,’’ suggests Kyle.

19 Close the report and click Yes to save changes.

To create a report using grouping:

1 Click Report Wizard in the Reports group of the Create tab on the
Ribbon.

2 Select Query: Product Query from the Tables/Queries drop-down
list.

3 Click >> to select all fields for inclusion in this report.

4 Click Category ID in the Selected Fields section, then click < to
remove the Category ID field from the list.

5 Select Table: Category Table from the Tables/Queries drop-down
list.

6 Double-click Category Name to add that field to the Selected Fields
list. (Note: It should appear just below ProductName.)

7 Click Next and then double-click CategoryName to add a grouping
level.

8 Click Next.

9 Select Product Name from the drop-down list 1 when asked about
sorting; this will sort your report by product name.
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‘‘Is it possible to group more than once?’’ Meagan asks.
‘‘Yes,’’ explains Kyle. ‘‘Access will let you group on any number of fields.’’
He suggests you create a report listing the product name and quantity by

category and by supplier. In this way you can see what products are in each
category as well as which suppliers provide them.

10 Click Next; then check the Adjust the field width check box so that
‘‘All fields fit on a page.’’

11 Click Stepped under the Layout section and Portrait under the Orien-
tation section; then click Next.

12 Type Report 2 as the title of your report and then click Finish. Your
window should look like Figure 13.6.

13 Close the report.

Figure 13.6
Partial View of Report 2

To create a report using multiple field grouping:

1 Click Report Wizard in the Reports group of the Create tab on the
Ribbon.

2 Select Table: Product Table from the Tables/Queries drop-down list.
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3 Double-click ProductName and Quantity from the list of available
fields.

4 Select Table: Category Table from the Tables/Queries drop-down
list.

5 Double-click Category Name from the list of available fields.

6 Select Table: Supplier Table from the Tables/Queries drop-down list.

7 Double-click Supplier Name from the list of available fields; then
click Next.

8 Click by Category Table as your data view and then click Next.

9 Double-click Supplier Name to add a grouping level. Your window
should look like Figure 13.7.

10 Click Next and the select Product Name from the drop-down list 1
when asked about sorting; this will sort your report by product name.

11 Click Next; then check the Adjust the field width check box so that
‘‘All fields fit on a page.’’

12 Click Stepped under the Layout section and Portrait under the Orien-
tation section; then click Next.

Figure 13.7
Multiple Grouping Levels
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‘‘I can imagine all sorts of reports I would like to generate in our business,’’
says Meagan. ‘‘But you said we could summarize as well, right?’’

‘‘Correct,’’ Kyle responds. ‘‘Let me introduce you to the summarizing
process.’’

Summarizing
Kyle explains that Access will automatically provide summaries on numeric
fields in your report if you use the Report Wizard and establish groups. He tells
you that a group is a collection of records, along with any introductory and
summary information displayed with the records, such as a header. A group
consists of a group header, nested groups (if any), detail records, and a group
footer. Grouping allows you to separate groups of records visually and to dis-
play introductory and summary data for each group. The available functions
include summation, average, minimum, and maximum. Access will also calcu-
late the percent of total for sums if you like.

13 Type Report 3 as the title of your report and then click Finish. Mod-
ify the size of each field so that your report looks like Figure 13.8.

14 Save and then close the report.

Figure 13.8
Partial View of Report 3

350 Part 2 Access for Accounting

Copyright 2014 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). Editorial review has 
deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



‘‘It’s important to remember that Access won’t let you sum text or other non-
numeric fields, for obvious reasons,’’ says Kyle. ‘‘So if you accidentally set up
a field in a table that contains numeric values but identify the field as a data
type other than number, you won’t be able to use the summary features.’’

He suggests creating a product value by category report that sums the total
value of products in each category.

To create a report using grouping and summary options
using the Report Wizard:

1 Click Report Wizard in the Reports group of the Create tab on the
Ribbon.

2 Select Query: Product Query from the Tables/Queries drop-down
list.

3 Double-click ProductName, Quantity, UnitCost, and TotalCost from
the list of available fields.

4 Select Table: Category Table from the Tables/Queries drop-down
list.

5 Double-click CategoryName from the list of available fields; then
click Next.

6 Double-click CategoryName as your group level, and then click
Next.

7 Click ProductName from the drop-down list 1 when asked about
sorting; this will sort your report by product name.

8 Click the Summary Options button in the Report Wizard box.

9 Click Sum on the TotalCost row to direct Access to add the total
value of each product by group.

10 Click OK in the Summary Options window.

11 Click Next; then check the Adjust the field width check box so that
‘‘All fields fit on a page.’’

12 Click Stepped under the Layout section and Portrait under the
Orientation section; then click Next.

13 Type Report 4 as the title of your report and then click Finish. Mod-
ify the size of each field so that your report looks like Figure 13.9.
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Kyle further explains the nature of the report just generated. In addition to
the total provided for each category, the report created a grand total value of all
products (see again Figure 13.8). However, the description of the summary
amount is a bit odd, and the value amounts are shown as ###.

‘‘To help you understand how this summary was created, I think it’s best to
show you the Report Design view of this report,’’ Kyle suggests. ‘‘Let’s open
up the report, take a look, fix these problems, and print the report.’’

14 Close Print Preview but leave the Report window open.

Figure 13.9
Partial View of Report 4

To examine the sum functions created in the previous report
and then print the report:

1 Click View and then Design View to view the design view of Report 4,
as shown in Figure 13.10.
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2 Note the Sum label control and the =Sum([TotalCost]) formula in a
text box control, both located in the Category ID footer.

3 Also note the Grand Total label control and the =Sum([TotalCost])
formula in a text box control, both located in the Report footer.

4 Click the left side of both Sum controls and drag to the left to increase
their size, as shown in Figure 13.11.

5 Right-click the =Sum([TotalCost]) control in the Category ID footer;
then click Properties to reveal the Property Sheet window.

6 Click the All tab to view the Property Sheet window, as shown in
Figure 13.12.

7 Observe that the formula in the Control Source section of the Proper-
ties window contains the formula to sum the TotalCost field of the
report.

8 Close the Properties window.

9 Click View and then click Report View.

Sum label control in the CategoryID footer Sum control in the CategoryID footer

Figure 13.10
Design View of Report 4
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10 Click the File tab, click Print, click Print again, and then click OK
to print the report. It should look like Figure 13.13.

11 Close the Report window. Click Yes to save the changes.

Control Source Formula

Click and drag the Sum control in the
CategoryID footer to make it larger

Figure 13.11
Increasing the Size of a Report Control

Figure 13.12
Partial View of the

Properties Window of
the Sum([TotalCost])

Control
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Figure 13.13
Printed Report 4
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‘‘Placement of these controls determines what gets summed,’’ Kyle explains.
‘‘The first control, placed in the CategoryName footer, sums the total value for
each category, while the second control, placed in the report footer, sums the
total value for the whole report.’’

‘‘Why is Total Value in brackets?’’ asks Meagan, ‘‘and why are the sum
amounts and totals without commas, dollar signs or full decimals?’’

‘‘The brackets indicate that a field name is being used in a formula,’’
explains Kyle. ‘‘The Sum function will sum all the fields named Total Value
located within the CategoryName detail section. The formatting of the controls
is something we can take care of next.’’

Kyle now advises you to learn more about reports by modifying an existing
report.

Modify an Existing Report

Not all reports you create with the Report Wizard will look the way you want
or present the information you need. It is therefore important that you be able
to modify an existing report. Kyle has explained how placement of controls in
the various sections of a report dictate the information displayed. He suggests
that you learn about each report section by creating controls to count and sum
and then modifying the properties of those controls.

Counting and Summing in Report Sections
Kyle explains that all reports have a detail section, but a report can also include
a report header, a page header, a group header, group footer, page footer, and a
report footer section. Each section has a specific purpose and prints in a predict-
able order in the report.

In Design view, sections are represented as bands, and each section that the
report contains is represented once. In a printed report, some sections might be
repeated many times. You determine where information appears in every section
by placing controls such as labels and text boxes.

The Report header appears once at the beginning of a report. You can use it
for items such as a logo, report title, or print date. The Report header is printed
before the Page header on the first page of the report. The Page header appears
at the top of every page in the report; you use it to display items such as col-
umn headings. The Detail section contains the main body of a report’s data.
This section is repeated for each record in the report’s underlying record source.
The Page footer appears at the bottom of every page in the report; you use it to
display items such as page numbers. The Report footer appears once at the end
of the report. You use it to display items such as report totals. The Report
footer is the last section in the report design but appears before the Page footer
on the last page of the printed report.

Kyle explains that the CategoryName footer generated by the Report Wizard
created a text box control for this report that specified not only which Category-
Name was being totaled but also how many detail records were in each cate-
gory section. This was accomplished by using the field name in the control and
using the Count function to add up the number of detail records in each
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category section. The CategoryName Header describes the field information
being grouped below it. In this case you chose to group information by
CategoryName. Alternatively, you could have chosen to group the product
information by buyer name or supplier name for example.

The formula used in the text box control was ¼’’Summary for ’’ & ’’’Cate-
gory ID’ ¼ ’’ & ’’ ’’ & [CategoryName] & ’’ (’’ & Count(*) & ’’ ’’ &
IIf(Count(*)¼1,’’detail record’’,’’detail records’’) & ’’)’’ In the report, this text
box control printed the following result for the first category: ‘‘Summary for
‘CategoryName’ ¼ 1 (5 detail records)’’. The most important part of the for-
mula is the function Count. To count records in a section, the formula Count
(*) is used. The & symbol is used to separate text from fields, and the IIf func-
tion changes the final text to read either record or records, depending on
whether one or more records were counted.

The CategoryName footer also included a text box control to sum the total
value for each category (note that the Report footer included the identical text box
control). The placement of the control in the CategoryName footer caused the con-
trol to calculate the total value for each category, while the control placed in the
Report footer caused that control to calculate the total value for the entire report.

‘‘Why don’t you use the report you just created to experiment on modifying
report sections by adding a control to sum the quantity of each category and
adding a control to count all detail records in the entire report?’’ Kyle suggests.

To modify report sections to sum and count:

1 Right-click Report 4 and then click Design View.

2 Right-click the Sum Of TotalCost control in the CategoryName footer,
click Properties, and note that the format is set to Currency by clicking
the Format drop-down list as shown. Currency (see Figure 13.14).

3 With the Property Sheet still open, click the Sum control in the Report
footer and note that the format of this control is also already set to
currency.

Select currency from
this drop-down list

Figure 13.14
Formatting the Sum
Control
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4 Close the Property Sheet window.

5 Select the Textbox button in the Controls group of the Design tab of
the Ribbon.

6 Click and drag your mouse in the CategoryName footer to create a
new text box control, as shown in Figure 13.15.

7 Click inside the new text box control (labeled Unbound) and type
=Sum([Quantity]).

8 Delete the new text box control label by clicking in the upper left cor-
ner of the label, and then press the [Delete] key.

9 Move and resize the newly created text box to line up with Quantity
in the detail section.

10 Click the top of the Grand Total label control in the Report footer to
see a move cursor; then, holding the mouse button down, move the
label to the right and place it next to the Grand Total amount.

11 Type Report 5 in the Report header, replacing the old title Report 4.

12 Click the File tab, click Save As, then click Save Object As, then
click Save As, then type Report 5 as the title and then click OK.

13 Right-click in the bottom section of the Design view under the Report
footer and click Properties to display the Property Sheet.

14 Type Report 5 as the caption, replacing the text Report 4.

Newly created text box Right click here, then click Properties to view
the Property Sheet window for the report.

Figure 13.15
Creating a New Control in a Report
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15 Select the Textbox button in the Controls group of the Design tab of
the Ribbon.

16 Click and drag your mouse in the Report footer to create a new text
box control.

17 Click inside the new text box control (labeled Unbound) and type
=Count(*).

18 Type Total detail records in the new text box control label.

19 Move and resize the newly created text box to line up with records
count in the detail section.

20 Click View and then click Layout View. (This allows you to see the
report in a view with the data provided and often makes it easier to
align fields and labels.)

21 Click View and then Report View, and then scroll to the bottom of
the report. Your screen should look like Figure 13.16.

22 Close the report, saving your changes.

Figure 13.16
Bottom Half of Report 5 in Report View
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Having added controls to Count records and Sum different values, it is now
time to modify various properties of those controls like borders, lines, fonts,
and so forth.

Lines, Borders, and Formatting in Report Sections
Access allows you to modify reports by adding lines and modifying properties
of existing controls like the font name, size, and weight. Kyle suggests that you
and Nathan look over the report you just modified and determine what changes
you think would add to its look and usefulness.

‘‘I think it would be nice to better separate each category section with a
line,’’ Nathan comments, ‘‘and get rid of that border around the grand total.’’

‘‘I agree,’’ you respond. ‘‘We should also have a line above each total for
the sum of watches, earrings, et cetera. Plus I would like to change the font
style of the controls in the Report footer to Times New Roman, size 10, bold,
and italicized.’’

‘‘How about making the total cost of each category look like currency?’’
Meagan suggests.

‘‘Go for it!’’ Kyle exclaims.

To add lines, modify borders, and change formatting:

1 Right-click Report 5 and then click Design View.

2 Type Report 6 in the Report header, replacing the old title Report 5.

3 Click the File tab and then click Save As, then click Save Object As,
then click Save As, then type Report 6 as the title and then click OK.

4 Right-click in the grayed-out section of the Design view under the
Report footer and click Properties to display the Property Sheet.

5 Type Report 6 as the caption, replacing the text Report 5; then close
the Property Sheet.

6 Click at the top of the Page Footer separator and then with the left-
mouse button held down, drag down to increase the size of
CategoryName Footer. You may also need to move the Sum label,
and two sum controls down a bit and then click the Line tool located
in the Controls group of the Design tab of the Ribbon.

7 Click and drag the mouse cursor from just under the label Sum in the
CategoryName footer to just under the lower right corner of the
¼Sum([Total]) text box. A line should appear.

8 With the line selected, click the Format tab of the Report Design
Tools section and then select the Shape Outline drop-down list, and
then select Line Type and then select Solid (it may already be solid).

9 With the line still selected, click the Format tab of the Report Design
Tools section and then select the Shape Outline drop-down list, and
then select Line Thickness and then select 1 pt.
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10 With the line still selected, click the Format tab of the Report Design
Tools section and then select the Shape Outline drop-down list, and
then select a black square to select a color for the line (it may already
be black).

11 Click the Line tool again.

12 Add a short line just above the =Sum([Quantity]) control in the Cate-
gory ID footer. A line should appear. Format the line in the same
manner as above.

13 Click View and then Layout View. Your screen should look like
Figure 13.17.

14 Type Products by Category (in place of Report 6) in the Report
header.

15 Click Save in the Quick Access toolbar to save changes to Report 6.

16 Click the File tab, click Print, and then click Print again.

17 Click OK in the Print window to print your report. The printed report
should look like Figure 13.18.

Line added here

Line added here

Figure 13.17
Adding Lines to Report 6
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‘‘Wow, that was a lot of work,’’ Meagan complains. ‘‘Why can’t the Report
Wizard do all this for us in the first place?’’

‘‘Good question,’’ Kyle answers. ‘‘Reports have so many variations that the
Report Wizard can only begin to create reports. The rest is up to us!’’

End Note

In this chapter you have learned how to use a query to create a report, how to
use grouping and summarizing to enhance a report’s usefulness, and how to
modify a previously generated report so that it will be more useful. Now you
are ready to take on the world and create your own solutions to database orga-
nization and reporting problems.

18 Close the report window.

Figure 13.18
Printed Products by Category Report
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Chapter 13 Questions

1 Why create a report from a query? Why not just print your query
results?

2 Can you always add a field from any table to a report based on a query?

3 When creating a report, what does grouping accomplish?

4 When creating a report, what does the process of summarizing accom-
plish?

5 Is it possible to group more than one item?

6 What do the [ ] (brackets) signify in an Access formula?

7 How do you determine where information appears in a report?

8 What type of control is used in a report to add values?

9 What function is used (and how is it written) to count records in a
report?

10 Describe the process of adding lines to a report.

Chapter 13 Assignments

1 Using the Ch13-02 file, create a report using all the fields present in the
Buyer Query. View the data by Product Table with no grouping or sum-
marization in a portrait orientation and adjusting the field width so all
fields fit on a page. Title and save the new report as Ch 13 Assignment
1. Print the new report.

2 Create a report using the BuyerName, ProductName, Quantity, UnitCost,
and TotalCost fields present in the Buyer query. View the data by Buyers
Table and group by BuyerName. Use the summary option feature of
Access to the sum TotalCost, showing detail and summary in a stepped
layout with portrait orientation and adjusting the field width so all fields
fit on a page. Title and save the new report as Ch 13 Assignment 2.
Make sure all values are visible, and then print the new report.

3 Open the report created in Assignment 2. Change the title of the report
to Products by Buyer. Add lines to separate each buyer. Add a line above
the grand total amount. Save the new report as Ch 13 Assignment 3.
Make sure all values are visible and then print the new report. Your
printed report should look like Figure 13.19.
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Chapter 13 Case Problem 1:

KELLY’S BOUTIQUE
Note: You must have completed Case 1 in the previous chapter in order to con-
tinue working on this case.

In the last chapter you added and modified some forms for Kelly’s Boutique.
She would now like you to create some new reports. Make the following
changes for Kelly using the ch12-03_student_name file you created in Chapter
12. (Note: Open your ch12-03_student_name file and then save it as ch13-
03_student_name before making the indicated changes.)

Figure 13.19
Completed Product

by Buyer Report
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a. Kelly would like you to modify an existing query (Ch 11 Kelly Case
h) to include the publisher name and then to save the new query as
Ch 11 Kelly Case o. Use this new query to generate a report listing
all of the field names provided in the query and grouped by publisher,
sorted by book title, with no summarizing, in a stepped layout with
portrait orientation. Save the newly created report as Ch 13 Kelly
Case a and then print the report, making sure that all fields of infor-
mation are clearly readable before printing.

b. Next, Kelly would like you to add some grouping to the report created
in Case 1a. Rather than modify the existing report, create a new report
using the Ch 11 Kelly Case o query to generate a report listing only
the publisher, book title, quantity, and cost, grouped by publisher and
sorted by book title, summing cost in a stepped layout with portrait
orientation. Save the newly created report as Ch 13 Kelly Case b and
then print the report, making sure that all fields of information are
clearly readable before printing.

c. Next, Kelly would like you to use the parameter query created previ-
ously (Ch 11 Kelly Case l) to create a report containing the fields
book title and quantify for a specified publisher and viewed by Book
Table, sorted by book title, with portrait orientation. Save the newly
created report as Ch 13 Kelly Case c. Add a field to count the number
of titles for the publisher specified and then sum the quantity of books
for that publisher. Add line controls, change the report title, and move
controls around so that your report looks like Figure 13.20.

Run the report for Random House and then print the report, making sure that
all fields of information are clearly readable before printing.

Chapter 13 Case Problem 2:

WINE DEPOT
Note: You must have completed Case 2 in the previous chapter in order to con-
tinue working on this case.

Figure 13.20
Report Example
for Kelly Case C
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In the previous chapter you modified some forms for the Wine Depot. Now
Barbara would like you to help her create some new reports. Make the follow-
ing changes for Barbara using the ch12-04_student_name file you created in
Chapter 12. (Note: Open your ch12-04_student_name file and then save it as
ch13-04_student_name before making the indicated changes.)

a. Use the Report Wizard to create and print a new report based on the
query created in Chapter 11 (Ch 11 Wine Depot Case b),which listed
all wine products purchased by Michael Jackson. Include all the fields
available from the query, view the data by wine products with no
grouping, sorted by type in ascending order, with portrait orientation.
Title the report Ch 13 Wine Depot Case a and then print the report,
making sure that all fields of information are clearly readable before
printing.

b. Use the Report Wizard to create and print a new report that lists the
following fields: buyer name, type, winery name, vintage, and quan-
tity. View your data by buyer and then by winery name, in ascending
order by type, in stepped layout with portrait orientation. Title the
report Ch 13 Wine Depot Case b and then print only page 1 of the
report, making sure that all fields of information are clearly readable
before printing.

c. Create a new report of product total cost by winery. Using your previ-
ous query (Ch 11 Wine Depot Case k) as the basis for this report,
include all the fields in that query and view them by winery. Sort the
detail by type in ascending order, and add a summary option for total
cost (in a Currency format) that shows detail and summary in a
stepped layout with portrait orientation. Title the report Ch 13 Wine
Depot Case c and then print only the last page of the report, making
sure that all fields of information are clearly readable before printing.

d. Modify your previous query (Ch 11 Wine Depot Case k) to be a pa-
rameter query by asking the user to specify a type of wine. Save the
new query as Ch 11 Wine Depot Case m. Use that query to create a
report of costs by type of wine. The report should include all the
fields from the query except type. View the data by winery name, in
ascending order by SKU, and in a stepped layout with portrait orienta-
tion. The report should calculate the sum of total cost for the wine
selected. Run the report for Pinot Noir wines. Modify the report to
look like Figure 13.21 by adding a line and a Grand Total in the
report footer. Then title the report as Ch 13 Wine Depot Case d and
print it, making sure that all fields of information are clearly readable
before printing.
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Chapter 13 Case Problem 3:

SNICK’S BOARD SHOP
Note: You must have completed Case 3 in the previous chapter in order to con-
tinue working on this case.

In the previous chapter you modified some forms for Snick’s Board Shop.
Now Caitlin would like you to help her create some new reports. Make the fol-
lowing changes using the ch12-05_student_name file you created in Chapter 12.
(Note: Open your ch12-04_student_name file and then save it as ch13-05_stu-
dent_name before making the indicated changes.)

a. Use the Report Wizard to create and print a new report based on the
query created in Chapter 12 (Query B), which included all products in
CategoryID 1. Include all the fields available from the query, view the
data by products with no grouping, sorted by manufacturer name in
ascending order, in a tabular layout with portrait orientation. Title the
report Report A and then print the report, making sure that all fields
of information are clearly readable before printing.

b. Use the Report Wizard to create and print a new report that lists the fol-
lowing fields: ManufacturerName, CategoryName, ProductName, and
Price. View your data by manufacturer and then by category, in ascend-
ing order by ProductName, in stepped layout with portrait orientation.
Title the report Report B and then print only page 1 of the report, making
sure that all fields of information are clearly readable before printing.

c. Create a new parameter query that includes the CategoryName, Manu-
facturerName, ProductName, Quantity, and Price for a CategoryName
specified when the query is run. Name this query Query L and then
create a new report containing the ManufacturerName, ProductName,
Quantity, and Price for a specified CategoryName and viewed by
ManufacturerName, sorted by ProductName, with portrait orientation.
Be sure to include a summary option which sums the quantity field in
detail and summary. Save the newly created report as Report C. Run
the report for CategoryName Complete and for CategoryName Long-
boards, and then print both reports.

Figure 13.21
Total Cost of Wines by
Name
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d. Create a new query that includes the CategoryName, ProductName,
Quantity, Price, and Discount fields. Add a calculated field called Dis-
countedRetailValue to this query, which computes the quantity times
the discounted price (Price x (1-Discount)) formatted as currency.
Save the new query as Query M.

e. Now create a report based on Query M that lists the CategoryName,
ProductName, and DiscountedRetailValue grouped by CategoryName,
sorted by ProductName with a sum of DiscountedRetailValue in the
detail and summary portions of the report. Save the new report as
Report D.

Chapter 13 Case Problem 4:

ROSEY’S ROSES
Note: You must have completed Case 4 in the previous chapter in order to con-
tinue working on this case. In the last chapter you created some forms for the
Rosey’s Roses. Now the company would like you to help it create some reports
to extract information from the database. Make the following changes using the
ch12-06_student_name file you created in Chapter 12. (Note: Open your ch12-
06_student_name file and then save it as ch13-06_student_name before making
the indicated changes.)

a. Use the Report Wizard to create and print a new report based on
Query D. Include all the fields available from the query, view the data
by Grower with no grouping, sorted by product Description in ascend-
ing order, in a stepped layout with portrait orientation. Title the report
Report A and then print the report, making sure that all fields of infor-
mation are clearly readable before printing.

b. Use the Report Wizard to create and print a new report that lists the fol-
lowing fields: Grower Name, Type, product Description, and Cost/Unit.
View your data by Grower and then by Type, in ascending order by
product Description, in stepped layout with portrait orientation. Title the
report Report B and then print only page 1 of the report, making sure
that all fields of information are clearly readable before printing.

c. Create a new parameter query that includes the Type, Grower Name,
product Description, Quantity, and Cost/Unit which asks ‘‘For which
type?’’ when the query is run. Name this Query L and then create a
new report containing the Grower Name, product Description, Quan-
tity, and Cost/Unit for a specified Type and viewed by Grower Name,
sorted by product Description, with a stepped layout and portrait ori-
entation. Be sure to include a summary option which sums the Quan-
tity field in detail and summary. Save the newly created report as
Report C. Run the report for Type Shrub and for Type Tree, and then
print both reports.

d. Create a new query that includes the Quote Number, Customer Name,
product Description, and Quantity Ordered fields. Add a calculated
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field called Sales Price which is the Cost/Unit times (1 plus Markup)
times (1 – Discount). Also include another calculated field called
Total Quote which computes the Quantity Ordered times the Sales
Price also formatted as currency and 2 decimal places. Save the new
query as Query M and then print it. (Hint: be sure to include the
Grower table in your query construction.)

e. Now create a report based on Query M that lists all the fields available
in that query in a tabular layout and landscape orientation. Save the
report as Report D. Using the Design View; delete the two existing
controls in the page footer. Now add two textbox controls. Add one
which sums the Quantity Ordered (general number format) and one
which sums the Quote Totals (currency format) in the report footer.
Also add a Totals label, and resize all labels and fields so that your
report looks like Figure 13.22.

Save the modified report and print it.

Figure 13.22
Quotes
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